REGN MED BIOLOGI — SUPPLERENDE MATERIALE (4.9)

Populationsgenetik
hos to hvalarter

| ‘Regn med biologi’ side 98, figur 94 vises et fylogenetisk stamtrae over grenlandshval og sydlig
rethval. Dette supplerende materiale viser hvorledes man kan finde sekvenser, fremstille et stam-
tree som det viste i figuren, og hvordan man kan regne pa genetiske forskelle i populationer ud
fra sadant et stamtrae.

Find sekvenser

For at undersege om der er forskel i genetisk variation hos de to hvalarter, kan man anvende
programmet ‘Geneious’ til at sege pa NCBI’s server. Herefter anvendes programmet MEGA til at
fremstille et stamtrae og til at kvantificere forskellene i de to nucleotiddatasaet (grenlandshval og
sydlig rethval). Begynd med at dbne Geneoius og markér ‘Nucleotide’ pa NCBI’s segefunktion —
som, vist pa figur 1.
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Figur 1. Segefunktionen i Geneious. Der skal seges pd nucleotider.

Der vil i populationer kun forekomme sma forskelle i DNA, og det geelder derfor om at sege pa
et omrade med en hurtig substitutionsrate og ingen bevarende selektion — kontrolregionen i
mtDNA er pa den baggrund velegnet til disse undersegelser. Man skal derfor sege pa hvalarten
grenlandshval (Balaena mysticetus) og pa ‘control region’. | figur 2 vises efter at have klikket pa
‘More options’ i Geneious’ segefelt og sa valgt ‘+’ for flere segninger i segefeltet: Seg pa ‘Bala-
ena mysticetus’ i det gverste segefelt og pa ‘control region’ i det nederste segefelt.

-

Match |all  w |of the following:
Any Field w | |contains + | |Balaena mysticetus L =

Any Fielci ¥ con.tains w | |control region ok —

Truncate sequences to (residuss): | Create Agent... | Search 4 Fewer Options

Figur 2. Segning pd grenlandshval og kontrolregionen i Geneious.

| denne undersagelse skal der bruges data til et stamtrae med de to hvalarter, og der skal bruges
data fra hver hvalart til kvantitativ analyse. Fremstil derfor en mappe ved at hgjreklikke pa ‘Local’
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i stistrukturen til hgjre og der veelge ‘New folder’; navngiv den ‘Hvaler’. P4 samme made opstil-
les to undermapper der henholdsvis hedder ‘Sydlig Rethval’ og ‘Grenlandshval’. | segningen
kommer der nu nogle sekvenser pa 453 baser frem blandt mange andre. Sortér i sekvenserne
ved at klikke pa ‘Sequence length’ i resultatvinduet som vist med red ring i figur 3. Markér alle
sekvenserne fra og med AF355204 til og med AF355271 (68 i alt) og traek dem over i mappen
‘Hvaler’.

Name Description Modified Organism Wc Accession GID Topology Molecule Type Taxonomy M.
o AF355258 Balaena mysticetus haplatype CCC mitochondri... 09 May 2002 Balaena mys...4 38.6% AF355258.1 15420497  linear DNA Eukaryota; .
o AF355259 Balaena mysticetus haplotype DDD mitochendri...09 May 2002 Balaena mys...453 38.9% AF355259.1 15420498 linear DNA Eukaryota; ..

Figur 3. Man kan sortere de fundne data ved at klikke pG overskriften over de enkelte kategorier.

Disse 68 filer traekkes ogsa over i mappen ‘Grenlandshval’. Man kan kopiere filerne fra en
mappe til en anden ved at holde <Crtl> eller <CMD> nede, mens man traekker filerne fra den
ene mappe til den anden.

Det samme gentages for sydlig rethval:

Foretag en segning som far, hvor ‘Nucleotide” markeres, og der seges efter ‘Eubalaena australis’
og ‘control region’.

Filerne med leengden 499-500 baser (AF395044-AF395053), i alt 9 sekvenser, overfares til map-
pen ‘Hvaler’ og til mappen ‘Sydlig rethval’.

Fordi Geneious' funktioner er begraensede, skal data feerdigbehandles i programmet ‘MEGA’.
Der er derfor to muligheder for at arbejde videre. Man kan lade Geneious lave alignmentet og
herefter eksportere alignede data til MEGA, eller man kan eksportere de fundne datafiler over i
MEGA som “*.fasta’-filer og sa foretage alt det yderligere arbejde, herunder alignment, i MEGA.
Begge dele gennemgas i denne tekst fordi man pa den made kan laere noget om, hvordan data
kan udveksles mellem programmer. Det er dog klart nemmest til dette formal at anvende den
forstnaevnte fremgangsmade.

Fremgangsmade 1: Alignment i Geneious

Dobbeltklik pa mappen ‘Hvaler’ og markeér alle filerne ved at trykke pa <Crtl>+A (pc) eller
<CMD>+A (Mac). Veelg herefter ‘Align/Assemble’” > ‘Pairwise/Multiple Align’ — vent til der kom-
mer en alignment-fil frem i mappen. Den hedder ‘Nucleotide alignment’. Klik pa den fil s& den
markeres.

Klik derefter i menulinjen: ‘Files” > ‘Export’ - ‘Selected Documents’ - ‘MEGA alignment
(*.meg)’. Herefter kommer en dialogboks frem hvor man kan navngive filen. Kald den ‘Hvaler’.
Under ‘Tags’ kan man skrive en note, men der behgver ikke at sta noget sa bare lad feltet sta
tomt. Nederste felt i dialogboksen henviser til hvor man vil gemme filen.

Gem fx pa skrivebordet og flyt evt. senere filen ind i en anden mappe. Man advares om at der
kan veere et datatab ved at ga fra ‘*.geneious-formatet til mega-, men tryk bare pa ‘Proceed’.
Fremstil pa samme made alignment af alle filerne i hver af mapperne ‘Grenlandshval’ og ‘Sydlig
Rethval’ og eksportér resultaterne som hhv. grenlandshval.meg og sydligrethval.meg (uden
mellemrum i filnavnet — filtypenavnet saetter programmet automatisk).
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Fremgangsmade 2: Alignment i MEGA
Filerne fundet i Geneious, eksporteres som *.fasta-filer hvor hver enkel sekvens placeres i en
enkel *.fasta-fil.

Disse samles til én *.fasta-fil, og man laver et alignment i MEGA.

Markeér alle datafiler i mappen ‘Hvaler’. Klik herefter pa ‘File’ > ‘Export’ > ‘Batch Export’.
Geneious foreslar at filerne eksporteres som Geneious-format, men veelg i stedet ‘FASTA sequen-
ces/aligment’ som vist pa figur 4. Eksportér filerne til skrivebordet.

[ NON ) Batch Export
File Format: | FASTA sequences/alignment a

~

Export to Folder: /Users/jesper/Desktop/Batch Export v Browse

Extension: .fasta

-3 Cancel _OK

Figur 4. Eksport af data som *.fasta-filer.

| naeste dialogboks trykkes ‘OK’ uden flueben i ‘Wrap sequence line’, og ‘Sequence’ skal vaere i

‘Upper case’. Der dukker nu en mappe op pa skrivebordet (hvis det er der, | har gemt den) som
hedder ‘Batch Export’. | den mappe ligger nu 69 fasta-filer som skal kombineres til én *.fasta-fil,

hvor sekvenserne star under hinanden, og som kan importeres i MEGA. Der er forskel i procedu-
ren, alt efter om man bruger en pc eller en Mac.

Samling af information i en fil

Pc

Klik pa starttasten (den med de fire felter som et flag) og skriv ‘CMD’. Der kommer et vindue
op med et kommandopromt. Et kommandopromt fungerer pa den made at man kan skrive
kommandoer og udfere dem ved at trykke pa <enter>. De kommandoer der skal foretages, skal
ske i mappen ‘Batch Export’ pa skrivebordet. Derfor skal der skiftes bibliotek til mappen ‘Batch
Export’. Det geres som vist i figur 5, ved at skrive ‘cd’ (change directory), trykke pa mellem-
rumstasten og treekke mappen ‘Batch Export’ ind i kommandopromtet.

e Kommandoprompt = B

icrosoft Windows [Uerszion 6.3.768081
(c> 2013 Microsoft Corporation. Alle rettigheder forbeholdes.

ssUserssdJesperred “"CisUserssJespersDesktopsBatch Export'

sUserssdespersDesktopinBatch Export>

Figur 5. Kommandopromtvinduet i en pc.

Efter tryk pa <enter> kan man som vist i figur 5, tredje linje, se at stien for ‘>’ peger ind i ‘Batch
Export’, og de kommandoer man laver herefter, foregar alene i mappen ‘Batch Export’ pa skri-
vebordet. Da *.fasta-filer er tekstfiler, kan de omdabes til tekstfiler vha. falgende kommando:

‘rename *.fasta *.txt’ <enter>
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Alle filerne beholder deres navne, men filtypen aendres. Herefter kopieres alle filernes indhold
sammen i en fil som kaldes ‘hvaler.txt’. Det geres vha. felgende kommando:

‘copy *.txt hvaler.txt’ <enter>

Kommandoen kan laeses som: Kopiér indholdet af alle filer der ender med ‘txt’, ind i filen ‘hva-
ler.txt’. Dette gares i alfabetisk reekkefolge efter filnavnet.

‘rename *.txt *.fasta’ <enter>

Filen ‘hvaler.fasta’ treekkes ud pa skrivebordet, og mappen ‘Batch Export’ slettes. Proceduren
gentages for filerne hhv. i mappen ‘Grenlandshval’ og ‘Sydlig Rethval’. Filerne der flyttes ud pa
skrivebordet, kaldes hhv. ‘grenlandshval.fasta’ og ‘sydligrethval.fasta’.

Mac
Man skal bruge to programmer: programmet ‘NameChanger’ (hentes i AppStore) og program-
met ‘Terminal’ som computeren har indbygget. Ga til ‘Lanchpad’ og start NameChanger og

Terminal.

Dobbeltklik pa mappen ‘Batch Export’, markér alle filerne og treek dem over i NameChan-
gers venstre side hvor der star ‘Original Filename’, som vist i figur 6. | boksen over ‘Original
Filename’ skrives ‘fasta’, og i boksen over ‘Renamed Filename’ skrives ‘txt’. Herved omdabes
* fasta-filer til tekst-filer ndr man trykker pa ‘Rename’.

® @ NameChanger
e o]
L2 via
Add Remove Clear Options Rename Image Browser
fasta Replace First Occurrence With B |t>ﬂ |
Original Filename Renamed Filename
AF355204.fasta AF355204.txt
AF355205.fasta AF355205.txt
AF355206.fasta AF355206.txt
AF355207.fasta AF355207.txt
AF355208.fasta AF355208.txt
AF355209.fasta AF355209.txt
o 46 files -

Figur 6. Omdebning af filer med NameChanger (Mac).

Start Terminal. Som vist i figur 7, er Terminal et kommandoprogram hvor man i tekst kan
indsaette forskellige kommandoer. | Terminalvinduet skriver man ‘cd ‘ (cd efterfulgt af et mel-
lemrum) og treekker mappen ‘Batch Export’ ind i Terminalvinduet. Tryk <enter>. Skriv herefter
‘cat *.txt > hvaler.txt’ (leeg maerke til at der er mellemrum pd begge sider af ‘>”). Afslut med at
trykke <enter>.

| NON ) " Batch Export — -bash — 80x7

Last login: Thu May 17 13:23:00 on console

Jespers—-iMac:~ jesper$ cd /Users/jesper/Desktop/Batch\ Export
Jespers-iMac:Batch Export jesper$ cat *.txt > hvaler.txt
Jespers—-iMac:Batch Export jesper$ I

Figur 7. Terminalvinduet pd en Mac.
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| NameChanger trykkes pa ‘Clear’, og i mappen ‘Batch Export’ findes filen ‘hvaler.txt” som traek-
kes over i NamChangers venstre side, hvor der i venstre boks sa skrives ‘txt’ og i hgjre boks skri-
ves ‘fasta’ — tryk ‘Rename’, og filen er omdebt til en *.fasta-fil. | mappen ‘Batch Export’ veelges
filen ‘hvaler.fasta’ som treekkes ud pa skrivebordet. Mappen ‘Batch Export’ slettes. Proceduren
gentages for filerne i hhv. mappen ‘Grenlandshval’ og ‘Sydlig Rethval’. Filerne der flyttes ud pa
skrivebordet, kaldes hhv. ‘grenlandshval.fasta’ og ‘sydligrethval.fasta’.

Fra *.fasta til en alignet fil i MEGA

Man har ndr man er naet hertil, tre filer liggende pa skrivebordet: enten hvaler.meg, grenlands-
hval.meg og sydligrethval.meg eller hvaler.fasta, grenlandshval.fasta og sydligrethval.fasta — alt
efter om man har fulgt fremgangsmade 1 eller fremgangsmade 2. Har man *.fasta-filer liggende
pa skrivebordet, skal de nu alignes:

Aben filen ‘hvaler.fasta’ i MEGA ved at vaelge ‘File’ > ‘Open a File/Session’. En dialogboks sper-
ger herefter om man vil analysere eller aligne data. Veelg ‘Align’. Programmet ‘Alignment Explo-
rer’ abner og ser ud som figur 8. Ved at klikke pa ‘W’ i menuen laves et alignment ved hjzelp

af ClustalW-algoritmen. Veelg ‘Align DNA’ og svar ‘OK’ til de forslag der derefter kommer op

— alignmentet er feerdigt pa fa gjeblikke. Vaelg herefter ‘Data’ > ‘Export Alignment’ > ‘MEGA
format’. Skriv OK til ‘Title’ og ‘No’ til ‘Protein-coding nucleotide sequence data’. Filen kommer
ud pa skrivebordet. Proceduren gentages for hhv. grenlandshval.fasta og sydligrethval.fasta.

Derved har man uanset fremgangsmade, filerne hvaler.meg, grenlandshval.meg og sydligret-
hval.meg liggende pa skrivebordet. Man kan ogsa veelge at lave et alignment ud fra Muscle-
algoritmen. Sa skal man klikke pa ikonet ved siden af W, som forestiller en bgjet arm.

m M7: Alignment Explorer (hvaler.fasta) - O X
Data Edit Search Alignment Web Sequencer Display Help

DS =&l wl o't B Y BX O mE| a0 ¢ a8
DNASequences Translated Protein Sequences
Species/Abbry Group Name i = ¥ * A
1. AF355204_Balaena_mysticetus_haplotype_A_mitochondrial_control_region_ GAAAAATATATTGTA
2 AF355205_Balaena_mysticetus_haplotype_B_mitochondrial_control_region_ GAAAAATATATTGTA
3. AF355206_Balaena_mysticetus_haplotype_C_mitochondrial_control_region_ .l.l.l.l.l.l.ll
4. AF355207_Balaena_mysticetus_haplotype_D_mitochondrial_control_region_ GAAAAATATATTGTA
5. AF355208_Balaena_mysticetus_haplotype_E_mitochondrial_control_region_ GAAAAATATATTGTA
6. AF355200_Balaena_mysticetus_haplotype_F_mitochondrial_control_region_ GAAAAATATATTGTA
7. AF355210_Balaena_mysticetus_haplotype_G_mitochondrial_control_region. GAAAAATATATTGTA
8. AF355211_Balaena_mysticetus_haplotype_H_mitochondrial_control_region_ GAAAAATATATTGTA
9. AF355212_Balaena_mysticetus_haplotype_I_mitochondrial_control_region_| .l.l.l.l.l.l.ll
10. AF355213_Balaena_mysticetus_haplotype_J_mitochondrial_control_region GAAAAATATATTEGTA
11. AF355214_Balaena_mysticetus_haplotype_K_mitochondrial_control_regior GAAAAATATATTGTA
12. AF355215_Balaena_mysticetus_haplotype_L_mitochondrial_control_regior GAAAAATATATTEGTA
13. AF355216_Balaena_mysticetus_haplotype_M_mitochondrial_control_regior GAAAAATATATTG
14. AF355217_Balaena_mysticetus_haplotype_N_mitochondrial_control_regior GAAAAATATATTGTA
15. AF355218_Balaena_mysticetus_haplotype_0O_mitochondrial_control_regior .l.l.l.l.l.l.ll
16. AF355219_Balaena_mysticetus_haplotype_P_mitochondrial_control_regior GAAAAATATATTGTAV
< >
Site#ﬁ S ®with O wio Gaos

Figur 8. Alignment Explorer i MEGA.
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Fremstilling af stamtree i MEGA

Fordi Geneious i gratisversionen ikke kan farve dele af stamtraeer, kan man lave stamtraeet i
MEGA som vist pa figur 94 side 98 i ‘Regn med biologi’. Aben filen ‘hvaler.meg’. Veelg ‘Phy-
logeny’ - ‘Construct/Test UPGMA tree’. Seet ‘Model/Method’ til ‘Jukes-Cantor-model’. Klik
‘Compute’. Stamtraeet der kommer frem, indeholder en masse information om grenleengde og
navn pa sekvenserne og andet. Klik pa ikonerne i venstre side sa ingen af ikonerne er markerede.
Derved fremstar stamtraeet som tegnet — uden yderligere information end selve stamtreeet.

Find den knude som samler alle individerne af sydlig rethval. Klik pa knuden og veelg ikon num-
mer 7 i venstre side som viser en farvet del af stamtreeet med en firkantet parentes omkring.
Ved klik pa dette ikon dbnes en boks der hedder ‘Subtree Drawing Options’ og som er vist i
figur 9. | fanebladet ‘Property’ seettes ‘Branch Line’ til at veere en anden farve end sort. | ‘Regn
med biologi’ er valgt bla. | fanebladet ‘Display’ fjernes flueben i ‘Display Bracket’. Klik pa ‘OK’.
Stamtreeets storrelse kan reguleres. Ikonet gverst der viser en hammer (se red ring figur 10), kan
seette afstanden mellem grenene, grenlaengden og bredden af stamtraeet. Et brugbart stamtrae
fremkommer hvis man seetter ‘Taxon Separation’ til 10 pixels, ‘Branch Length’ til 100 og ‘Tree
Width’ til 400.

m M7: Subtree Drawing Options X

Property Display Image

Name/Caption
| | Font

Node/Subtree Marker

] Apply to Taxon Markers

Branch Line

tnes [ | color I
wa | o]
. | s ]

D Overwrite Downstream Default
? e X oo

Figur 9. Mulighed for at markere dele af et stamtrce som noget andet end det avrige stamtree.

m M7: Tree Explorer: Hvaler.meg

File Search |Image Subtree View Compute Caption Help

Ben(8): &l<cio

Figur 10. Redigering af stamtrceets sterrelsesforhold.
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Kvantitativ analyse

En rigtig god funktion i MEGA er at programmet kan lave afstandsmatrixer. Det skal nu underse-
ges hvad den gennemsnitlige forskel pa sekvenserne er for henholdsvis grenlandshval og sydlig
rethval. Begynd med at abne filen ‘grenlandshval.meg’ i MEGA.

Veelg som vist pa figur 11, herefter ‘Distance’ - ‘Compute Overall Mean Distance’. Veelg Model/
Method til at vaere ‘p-distance’.

e MEGA 6.06(6140226)

File Analysis Help
= n e . % 8 . ®m B 0O
Align Datz Phylogeny  User Tres Ancestors  Selection Rates Clocks Diiz{

Figur 11. Menulinjen med mulighed for at fremstille afstandsmatrixer.

Der fremkommer herefter en beregning af den gennemsnitlige forskel i sekvenserne inden for
de fundne arter af grenlandshval. Det ses af figur 12a at forskellen er 0,0184 for grenlandshval.
Gares det samme for sydlig rethval fas som vist i figur 12b, en middelvaerdi pa 0,0204, der altsa
er hgjere end for grenlandshvalen. Med de data der her er til radighed, kan man derfor under-
bygge at jagten pa grenlandshval har medfert et tab af genetisk variation, idet variationen er
storre blandt de 9 rethvaler end blandt de 68 grenlandshvaler.

a b

(@ © %] M7: Overall mean distance (C:\users\jesper\... [ 0 [X] M7: Overall mean distance (C:\users\jesper\...
File Display Caption Help File Display Caption Help

0.0 0,00 0.0 n.oo0
Lo fenl %] 8 IR AR
d | d |
1. Overall 1. Overall
d [1,1] § Hucleotide: p-distance d [1,1] } Mucleotide: p-distance

Figur 12. Gennemsnitlig genetisk forskel pd bestande (p-afstand). a. Grenlandshval, b. Sydlig rethval.

Evt. viderebehandling i Excel

Dnsker man at overfare sine data til Excel for at foretage yderligere beregninger, kan man veelge
‘Distance’” - ‘Compute Pairwise Distances’. Svar ‘OK’ til de dialogbokse der fremkommer. Veelg
derefter ‘Compute’, og programmet danner en afstandsmatrix med p-afstande. Hvis man klikker
pa ‘XL’ i menuen for oven, kan man fa overfert matrixen til Excel og regne videre dér. Hvis man
vil eksportere en matrix og ikke bare en kolonne med parvise sammenligninger, skal ‘Export
Type’ som vist i figur 14, aendres til ‘Matrix’ (der er en begreensning pa 255 kolonner), og man
kan ogsa fastleegge antallet af decimaler (veelg 4) — jo lavere p-veerdier, jo flere decimaler er
nedvendige. Ved tryk pa ‘Print/Save Matrix’ starter Microsoft Excel (Windows), eller man kan
gemme en Excel-fil som man navngiver (Mac).
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@ O @ |X| M7:Distance Write-out Options

Output Format |}{|_: Micrasoft Excel warkbaok ;|
Ini tion to Wyrite———
UEMIEHSTEE L Decirmal Places I 4 vl
* Distances Export Type
Inﬂatrix (255 cols ma]| |
Matrizx
Lowerleft LI | & PrintiSave hatrix I

x Qancell ? Help |

Figur 14. Eksport af afstandsmatrix til Excel fra MEGA.
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